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Read This First

Community Resources

The following link connects to Tl community resources. Linked contents are provided "AS 1S" by the
respective contributors. They do not constitute Tl specifications and do not necessarily reflect TI's views;
see TI's Terms of Use.

TI Embedded Processors Wiki —Texas Instruments Embedded Processors Wiki

Established to assist developers using the many Embedded Processors from Texas Instruments to
get started, help each other innovate, and foster the growth of general knowledge about the
hardware and software surrounding these devices.
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If You Need Assistance. . .

If You Need Assistance. . .

If you wantto . ..

Do this . ..

Request more information about Texas Instruments Digital
Signal Processing (DSP) products

Call the CRC® hotline:

(800) 336-5236

Or write to:

Texas Instruments Incorporated

Market Communications Manager, MS 736
P.O. Box 1443

Houston, Texas 77251-1443

Order Texas Instruments documentation

Call the CRC® hotline:
(800) 336-5236

@ Texas Instruments Customer Response Center
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About This Manual

FCC Warning

This equipment is intended for use in a laboratory test environment only. It generates, uses, and can
radiate radio frequency energy and has not been tested for compliance with the limits of computing
devices pursuant to subpart J of part 15 of FCC rules, which are designed to provide reasonable
protection against radio frequency interference. Operation of this equipment in other environments may
cause interference with radio communications, in which case the user at his own expense will be required
to take whatever measures may be required to correct this interference.

Information About Cautions and Warnings
This book may contain cautions and warnings.

CAUTION
This is an example of a caution statement.

A caution statement describes a situation that could potentially damage your
software or equipment.

WARNING
This is an example of a warning statement.

A warning statement describes a situation that could potentially
cause harm to you.

The information in a caution or a warning is provided for your protection. Please read each caution and
warning carefully.
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Register, Field, and Bit Calls

The naming convention applied for a call consists of:
* For a register call: <Module name>.<Register name>; for example: UART.UASR
» For a bit field call:

— <Module name>.<Register name>[End:Start] <Field name> field; for example, UART.UASR[4:0]
SPEED bit field

— <Field name> field <Module name>.<Register name>[End:Start]; for example, SPEED bit field
UART.UASRJ[4:0]
* For a bit call:

— <Module name>.<Register name>[pos] <Bit name> bit; for example, UART.UASR[5]
BIT_BY_CHAR bit

— <Bit name> bit <Module name>.<Register name>[pos]; for example, BIT_BY_CHAR bit
UART.UASR[5]

To help the reader navigate the document, each register call is hyperlinked to its register description in the
register manual section. After each register description, a table summarizes all hyperlinked register calls.

To navigate in the PDF documents, see Acrobat Reader Tips.
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Coding Rules

The programming models or code listings follow the rules:

Type Definition Example
File Starts with the module name PRCM_testl.c
MCBSP1_init.h
Variable Global variables are prefixed by "g_" g_SDMA_LogicalChan
Pointers are prefixed by "p" pAddrCounter
Global pointers are prefixed by "g_p" g_pSDMA_LogicalChan
Function Starts with the module name PRCM_SetupClocks()
ArmintC_Maskinterrupts()
Typedef Ends with "_t" PRCM_Struct_t
Definition Starts with the module name and is followed by the #define SMS_ERR_TYPE *((volatileUint32*)0x680080F4)
register name #define MCBSP2_RCR1_REG *((volatile Uint32*)0x4807401C)
Enumeration Starts with the module name Typedef enum DMA_Mode_Label

{

INPUT_MODE
OUTPUT_MODE
} DMA_Mode_t;
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Flow Chart Rules

Flow Chart Rules

Flow charts follow the following rules:

Shape

Name

Definition

Process

Any computational steps or processing function of a program; defined
operation(s) causing change in value, form, or location of information

Decision

A decision or switching-type operation that determines which of a number
of alternate paths is followed

Predefined process or sub-
process

One or more named operations or program steps specified in a
subroutine or another set of flow charts

<
[T

General I/O function; information available for processing (input) or

Data or /O recording of processed information (output)

Terminator Terminal point in a flow chart: start, stop, halt, delay, or interrupt; may
show exit from a closed subroutine

Annotation Additional descriptive clarification, comment

On page connector (reference)

Exit to, or entry from, another part of chart in the same page

Off page connector (reference)

The flow continues on a different page.

Summing Junction

Logical AND

Logical OR

Parallel mode (1SO)

Beginning or end of two or more simultaneous operations

Flow Line

Lines indicate the sequence of steps and the direction of flow.
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Acrobat

Reader Tips

Acrobat includes two methods to search for words in a PDF:

The Find toolbar provides a basic set of options to locate a word in the current PDF.
The Search window lista words or partial words that match your text in the current PDF.

These guidelines apply to Acrobat Reader 5.x, 6.0, and 7.0.

For more information on Acrobat Reader search features, see the Adobe Reader Help.

To
1.

akrwn

To

akrwnh e

search for words in a document using the Find dialog box:

Open the document.

To display the Find toolbar, right-click in the toolbar area and select Find.

In the Find box, type the word, words, or partial words for which you want to search.
From the Find Options menu, select options as desired.

To view each search result, click the Find toolbar, the Find Previous button, or the Find Next button to
go backward or forward through the document.

search for words in a document using the Search PDF window:

Open the document.

Click the Search button on the File toolbar or right-click on your document and select Search.
Type the word, words, or part of a word for which you want to search.

Click Search.

The results appear in page order and, if applicable, show a few words of context. Each result displays
an icon to identify the type of occurrence. All other searchable areas display the Search Result icon.

To display the page that contains a search result, click an item in the Results list. The occurrence is
highlighted.

To navigate to the next result, choose Edit > Search Results > Next Result (or Ctrl+G).
To navigate to the previous result, choose Edit > Search Results > Previous Result (or Shift+Ctrl+G).

Navigate through your previous view

To retrace your path within an Adobe PDF document:
For the previous view: Choose View > Go To > Previous View or Alt+Left Arrow.

For the next view: Choose View > Go To > Next View or Alt+Right Arrow. The Next View command is
available only if you have chosen Previous View.

If you view the PDF document in a browser, use options on the Navigation toolbar to move between
views.

* Right-click the toolbar area, and then choose Navigation.
¢ Click the Go To Previous View button or the Go To Next View button.

NOTE: This navigation tip is useful to return to your previous view after clicking on a register call
hyperlink.
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OMAP3 Disclaimer

All programming models and use cases presented in this manual are provided for educative purposes only
and may differ from or be optimized for your applications.

All OMAP peripheral devices presented in this manual are provided for illustration purposes and may be
different from those in your system.

Trademarks
TMS320DMC64x, C64x, M-Shield and FlatLink3G are trademarks of Texas Instruments Incorporated.
ARM, JAZELLE, and THUMB are registered trademarks of ARM Limited.
ETM, ETB, ARM9, CoreSight, Cortex and Neon are trademarks of ARM Limited.
Bluetooth is a registered trademark of Bluetooth SIG, Inc. and is licensed to Texas Instruments.

Memory Stick is a registered trademark of Sony Corporation, and Memory Stick PRO is a trademark of
Sony Corporation.

HDQ is a trademark of Benchmarg.

1-Wire is a registered trademark of Dallas Semiconductor.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.
USSE and POWERVR are trademarks or registered trademarks of Imagination Technologies Ltd.

Mentor Graphics is a registered trademark of Mentor Graphics Corporation or its affiliated companies in
the United States and other countries.

SonicsMX, Sonics3220 are trademarks or registered trademarks of Sonics, Inc.

Foveon X3 is a registered trademarks of Foveon, Inc.

Super CCD Honeycom is a registered trademark of Fuji Photo Film Co., Ltd.

Linux is a registered trademark of Linus Torvalds.

Symbian and all Symbian based trademarks and logos are trademarks of Symbian Software Limited.
Synopsys is a registered trademark of Synopsys, Inc.

MIPI is a registered trademark of the Mobile Industry Processor Interface (MIPI) Alliance.

OneNAND is a trademark of SAMSUNG.

All other trademarks are the property of their respective owners.
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History
The following table summarizes the AM35x TRM versions.
Version Literature Number Date Notes
* SPRUGRO October 2009 See @
A SPRUGRO June 2010 See @
B SPRUGRO July 2010 See @
C SPRUGRO November 2013 See @
@ AM35x ARM Microprocessor Technical Reference Manual - * version (SPRUGRO) initial release.
@ AM35x ARM Microprocessor Technical Reference Manual - version A (SPRUGRO).
e Chapter 7: DMA
e Chapter 12: Display Subsystem
e Chapter 14: UART/IrDA/CIR
e Chapter 16: Multichannel SPI
e Chapter 17: Multichannel Buffered Serial Port
®  AM35x ARM Microprocessor Technical Reference Manual - version B (SPRUGROB).
»  Chapter 8: Interrupt Controller
e Chapter 14: UART/IrDA/CIR
@ AM35x ARM Microprocessor Technical Reference Manual - version C (SPRUGROC).
e Chapter 1: Introduction
* Chapter 4: Power, Reset, and Clock Management
e Chapter 18: Multichannel Buffered Serial Port
*  Chapter 20: Universal Serial Bus (USB)
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Introduction

This chapter introduces the features, supporting subsystems, and architecture of the AM35x ARM

Microprocessors.
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1.1

Overview

The AM35x ARM Microprocessors are integrated on TI's advanced 65-nm process technology.

NOTE: This technical reference manual describes all available features. Some features may not be
available or supported on your particular device. For more information, see your device-
specific data manual and Section 1.4, Device Family.

These devices are designed to provide maximum flexibility for ARM based applications including, but not
limited to, Industrial Automation/Control, Single Board Computers, and Human Machine Interface.

These devices also feature M-Shield™ mobile security technology to enable secure e-commerce
applications and the replay of copyright-protected digital media content.

Security features integrated on these devices support applications designed for:

* Protection against malicious attacks

* M-commerce

» Content protection for recordable media (CPRM)

» Digital rights management (DRM)

High-security (HS) devices rely on a security scheme based on hardware mechanisms and secure read-
only memory (ROM) code, ensuring that only trusted code can access secure resources. These resources

are in specific regions of memory as well as in peripherals, hardware cryptographic accelerators, and
eFuse keys.

NOTE: To determine if a high-security (HS) version of your device is available and for more
information on HS devices, see your device-specific data manual and Section 1.4, Device
Family.

The device supports high-level operating systems such as:
*  Windows CE

e Linux

Multiple RTOS are also supported.

These devices also include state-of-the-art power-management techniques required for high-performance
mobile products.

The following subsystems are part of the device:
* Microprocessor unit (MPU) subsystem based on the ARM® Cortex™-A8 microprocessor
* SGX subsystem for 3D graphics acceleration to support display and gaming effects

NOTE: SGX is not available on all devices. For more information see your device-specific data
manual and Section 1.4, Device Family.

» Camera image signal processor (VPFE) that supports multiple formats and interfacing options
connected to a wide variety of image sensors

» Display subsystem with a wide variety of features for multiple concurrent image manipulation, and a
programmable interface supporting a wide variety of displays. The display subsystem also supports
NTSC/PAL video out.

« Level 3 (L3) and level 4 (L4) interconnects that provide high-bandwidth data transfers for multiple
initiators to the internal and external memory controllers and to on-chip peripherals

These devices also offer a comprehensive power and clock-management scheme that enables high-
performance and low-power operation.

136

Introduction SPRUGROC-0October 2009—-Revised November 2013

Submit Documentation Feedback
Copyright © 2009-2013, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SPRUGR0C

13 TEXAS

Environment

i

INSTRUMENTS
www.ti.com
1.2 Environment
This section provides an overview of the device when integrated with the TPS65023 power integrated
circuit (IC). For more information on the TPS65023 device, contact your Tl representative.
Figure 1-1 provides an overview of a nonexhaustive environment for the high-tier device.
Figure 1-1. Environment Using TPS65023
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NOTE: Some features are not available on all devices. For more information. see your device-
specific data manual and Section 1.4, Device Family.
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1.3 Description

These devices are offered in the following package:

* ZCN package: 491-pin BGA (17x17, 0.65mm pitch)
e ZER package: 484-pin PBGA (23x23, 1mm pitch)
Figure 1-2 shows the block diagram.

Figure 1-2. Block Diagram
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NOTE: Some features are not available on all devices. For more information, see your device-
specific data manual and Section 1.4, Device Family.
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1.3.1 MPU Subsystem

The MPU subsystem integrates the following modules
e ARM subchip
— ARM® Cortex™-A8 core

— ARM Version 7™ |SA: Standard ARM instruction set + Thumb®-2, Jazelle® RCT Java accelerator,
and media extensions

— NEON™ SIMD coprocessor (VFP lite + media streaming instructions)
— Cache memories
e Level 1: 16KB instruction and 16KB data—4-way set associative cache, 64 bytes/line
» Level 2: see Section 1.4, Device Family
* Interrupt controller (MPU INTC) of 96 synchronous interrupt lines
» Asynchronous interface with core logic
» Debug, trace, and emulation features: ICE-Crusher, ETM, ETB modules

1.3.2 On-Chip Memory

On-chip memory configuration offers memory resources for program and data storage:
+ 112KB ROM
* 64KB single-access static random access memory (SRAM)

1.3.3 External Memory Interfaces

The device includes two external memory interfaces:
» General-purpose memory controller (GPMC)

— NOR flash, NAND flash (with ECC Hamming code calculation), SRAM and Pseudo-SRAM
asynchronous and synchronous protocols

— Flexible asynchronous protocol control for external ASIC or peripheral interfacing
— 16-bit data, up to 8 chip-selects (CSs)
— 128M-byte addressable per chip-select, 1G-byte total address space
— Nonmultiplexed device with limited address (2K bytes)
e SDRAM Controller (SDRC)
— Double data rate (DDR2 and LPDDR) SDRAM

— 16-bit or 32-bit data, 2 chip-selects, configurations for a maximum of 1 G-byte address space per
chip-select

— Work in conjunction with the SDRAM memory scheduler (SMS) companion module

1.3.4 DMA Controllers

The device embeds one generic DMA controller, the system DMA (sDMA) controller, used for memory-to-
memory, memory-to-peripheral, and peripheral-to-memory transfers:

* One read port, one write port

e 32 prioritizable logical channels

» 96 hardware requests

* 256 x 32-bit FIFO dynamically allocable between active channels

The device also embeds two dedicated DMA controllers: display DMA and USB HS DMA.
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1.3.5 Multimedia Accelerators

The device uses the following multimedia accelerators for display and gaming effects as well as high-end
imaging and video applications:

» 3D graphics accelerator (SGX)

3D graphics and video codecs supported on common hardware
Tile-based architecture

Universal scalable shader engine (USSE™) multithreaded engine incorporating pixel and vertex
shader functionality reducing die area

Advanced shader feature set in excess of Microsoft VS3.0, PS3.0, and OGL2.0
Industry standard API supports OGL-ES 1.1 and 2.0, OpenVG 1.0, and OpenMax
Fine-grained task switching, load balancing, and power management

Programmable high-quality image anti-aliasing

Advanced geometry DMA driven operation for minimum CPU interaction

Fully virtualized memory addressing for OS operation in a unified memory architecture
Advanced and standard 2D operations (that is, vector graphics, BLTs, ROPs, etc.)

» Video Processing Front End (VPFE)

Supports most of the raw and smart image sensors available in the market
16-bit parallel interface supported
Pixel clock up to 75 MHz

CAUTION

Clock configurations depend on the core voltage and maximum clock
frequencies. Values in this document might not apply to production devices.
Refer to your device-specific data manual for supported values for
production devices.

» Display interface

Display controller

Color and monochrome displays up to 2048 x 2048 x 24-bpp resolution
256 x 24-bit entries palette in red, green, blue (RGB)

3,375 colors, 15 grayscales

Picture-in-picture (overlay), color-space conversion, rotation, color-phase rotation, and resizing
support

Remote frame buffer interface

Liquid-crystal display (LCD) pixel interfaces (MIPI DPI 1.0) and LCD bus interfaces (MIPI DBI 1.0)
supported

NTSC/PAL video encoder outputs with integrated digital-to-analog converters (DACs) output are
supported on CVBS and S-video TV analog output signals

Embedded DMA controller
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1.3.6 Security (HS Devices Only)

The secure firmware resides in a secure version of the ROM and includes hardware security features that
enable HS devices and encryption/decryption accelerators. The following encryption/decryption
accelerators are only available in HS devices:

* RNG

» 2 x DES/3DES

+ SHA1/MD5

+ SHA2/MD5

* 2 x AES with counter mode

* Fast PKA

ghe_ customer programmable fuse ROM (CPFROM) module is only available on high-security (HS)
evices.

NOTE: To determine if a high-security (HS) version of your device is available and for more
information on HS devices, see your device-specific data manual and Section 1.4, Device
Family.

1.3.7 Comprehensive Power Management
The device includes the following power management features:
» Clock and reset generation and distribution
» Auto clock gating to save active power by gating clock when peripheral is not active
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1.3.8 Peripherals

The device supports a comprehensive set of peripherals to provide flexible and high-speed interfacing and
on-chip programming resources. Table 1-1 provides a list and description of the peripherals that are

available.
Table 1-1. Device Peripherals
Type Name Number | Description
Multi-channel Buffered 5 The McBSPs provide a full-duplex direct serial interface between
Serial Ports (McBSPs) the device and other devices in a system such as audio and
voice codecs and other application chips.
McBSP1, McBSP2, and McBSP3 serve as general purpose
serial ports while McBSP2 and McBSP3 include additional
audio-loopback capability.
Multi-channel Serial Port 4 The McSPIs provide a master/slave interface to SPI devices.
Interface (McSPI)
High-speed Multi-port 1 High-speed USB2.0 host controller with three host ports each
USB Host Controller offering high-speed data transactions (up to 480 Mbps) or full-
speed/low-speed data transactions (12 and 1.5 Mbps,
respectively).
In high-speed mode, the USB host controller ports interface to
external USB PHYs using a 12-pin or 8-pin UTMI low pin
interface (ULPI). In full-speed and low-speed mode, the ports
interface to external USB PHYs using a 6-/4-/3-pin serial
) o interface.
Serial Communication - - -
High-speed USB OTG 1 High-speed USB2.0 OTG controller that offers high-speed data
Controller transactions (up to 480 Mbps) on a USB port with embedded
DMA controller.
The high speed USB OTG controller includes integrated PHY,
thus eliminating need of external PHY.
HDQ/1-Wire® 1 The HDQ/1-Wire interface supports the Benchmark HDQ
protocol and the Dallas Semiconductor 1-Wire protocol.
Universal Asynchronous 4 Serial communication interfaces compatible to the industry
Receiver/Transmitter standard TL16C550 asynchronous communications element.
(UART) UARTL1 and UART 2 are general serial communication
interfaces. UART3 provides additional support for infrared data
association (IrDA) and consumer infrared (CIR) communications.
High-speed (HS) Inter- 3 Master/slave 12C high-speed standard interfaces with support for
integrated Circuit (12C) standard mode (up to 100K bits/s), fast mode (up to 400K
Controllers bits/s), and high-speed mode (up to 3.4M bits/s).
HECC Interface used to connect to vehicle bus in automotive.
Multimedia Card/Secure 3 MMC memory card, SD memory card, or SDIO cards interface.
. Digital/Secure Digital I/O
Removable Media (MMC/SDIO) Card
Interface
GP timers 12 Twelve general-purpose timers
Watchdog timers 1 Three watchdog timers
(WDTs)
32-kHz synchronization 1 32-kHz clock timer
. timer
Miscellaneous - - -
General-purpose Package- | General-purpose input/output pins controlled by six GPIO
input/output (GPIO) specific | controllers.
EMAC 1 10/100 Mbit Ethernet MAC operation with CPPI14.0 compliant &
RMII interface. Interface used to connect to vehicle
Control module 1 1/0 multiplexing and chip-configuration control.

Security Modules (High-
security Devices Only)

RNG, Fast PKA, 2xDES/3DES, SHA1/MD5, SHA2/MD5, 2xAES,
and Secure Watchdog Timer.
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1.4 Device Family

1.4.1 Device Features

Devices are configured with different sets of features on different devices. This technical reference manual

details all available features. Some features may not be available or supported in your particular device.

Features supported across different devices are shown in Table 1-2 (ZCN package). For more information
on the ZCN package, refer to your device-specific data manual.

Table 1-2. Subsystem, Co-Processor, and Peripheral Support Matrixon the (ZCN Package)

Subsystem/Co-Processor/Peripheral Chapter AM3517 AM3505

POWERVR SGX™ 3D Graphics Accelerator 11 X
Cortex-A8 Neon Co-Processor 3 X X
SDRAM Controller 9 X X
General-Purpose Memory Controller X X
VPFE 10 X X
Display Subsystem 12 X X

LCD DPI, LCD RFBI and TV Output Interface X X

LCD DSl and LCD SDI
McBSP1/2/3/4/5 17 X X
McSPI1/2/3/4 16 X X
High-Speed USB OTG Controller 20 X X
High-Speed USB Host Controller 20 X X
HDQ/1-Wire 18 X X
UART1/2 14 X X
UART3/IrDA/CIR 14 X X
12C1/2/3 15 X X
EMAC 22 X X
HECC 23 X X
MMC/SD/SDIO1/2/3 19 X X
GP Timer (x12) 13 X X
Watchdog Timer 13 X X
32-kHz Sync Timer 13 X X
GPIO 21 X X
Secure ROM 1
RNG 1
DES/3DES 1
SHA1/MD5 1
SHA2/MD5 1
AES 1
Fast PKA 1
Secure Watchdog Timer 1
High-security Device 1
General-purpose Device 1 X X
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1.4.2 Device Identification

The identification registers include the CONTROL_IDCODE and CONTROL_DIE_ID data registers. These
registers are accessible through the L4 interconnect port starting at physical address 0x4830 A204 and
0x4830 A218, respectively. See the Memory Mapping chapter for more information about the L4 memory
space mapping. Table 1-3 describes the identification registers.

The silicon type can be read in the HAWKEYE bit field value of the CONTROL.CONTROL_IDCODE
register. The silicon revision can be read in the VERSION bit field value of the
CONTROL.CONTROL_IDCODE register.

Table 1-3. Device Identification Registers

Register Name Address Size
CONTROL.CONTROL_IDCODE[31:0] 0x4830 A204 32
CONTROL.CONTROL_DIE_ID[127:0] 0x4830 A218 128

To retrieve chip identification, see Table 1-4. This register helps software identify the chip derivative.

Table 1-4. Chip Identification

gges";fr's . Name Bit | Value | Description AM3517 | AM3505
SGX SGX_scalable_control 14:13 00 Full use. 00
01 Core clock restricted in HW to /6 from L3.
10 HW not present. 10
11 Reserved.
Reserved Reserved 12 0 Reserved. Not available for use. 0 0
MPU L2 Cache MPU_L2_cache_size 11:10 00 0 KB.
Size 01 |64KB.
10 128 KB.
11 Full use (256 KB). 11 11
MPU Frequency ARM_MHz 9:8 00 500 MHz. 00 00
01 400 MHz.
10 266 MHz.
11 Reserved.
Reserved Reserved 75 1 Reserved. Not available for use. 0 0
NEON & VFP NEON_VFPLite 4 0 Full use. 0 0
1 Not available for use.
Reserved Reserved 3:2 1 Reserved. Not available for use. 0 0
MMC1 Width 4_8_bit_mmc 1 0 | Full use (8-bit width at 3.0v 10) 0 0
1 Restricted use (4-bit width at 3.0v 10)
TV Out TO_OUT 0 0 Full use. 0 0
1 Not available for use.
Control Device Status Register 15:0 (Address 0x4800 244C) 0x0CO00 0x4C00
Table 1-5. CONTROL_IDCODE Register Definition
Field Bits Value Comment
CONTROL.CONTROL_IDCODE [31:28] VERSION See Table 1-6 Revision number
CONTROL.CONTROL_IDCODE [27:12] HAWKEYE See Table 1-7 Hawkeye number
CONTROL.CONTROL_IDCODE [11:1] TI_IDM 0x13 Manufacturer identity (TI)
CONTROL.CONTROL_IDCODE [0] -- 0x1 Always set to 1.
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Device Family

The Hawkeye number is hardcoded in the design. Table 1-7 lists the Hawkeye number values, and
Table 1-6 lists the silicon revision values.

Table 1-6. Revision Number Value

Silicon Type Field Value
ES1.0 CONTROL.CONTROL_IDCODE[31:28] 0000
ES1.1 CONTROL.CONTROL_IDCODE[31:28] 0001

Table 1-7. Hawkeye Number Value

Silicon Type Field Value
ES1.0 CONTROL.CONTROL_IDCODE[27:12] 0xB868
ES1.1 CONTROL.CONTROL_IDCODE[27:12] 0xB868

The CONTROL.CONTROL_DIE_ID register is the 128 bits single identifier of the device.

Table 1-8. CONTROL_DIE_ID

Field Bits Value

DIE_ID[127:0] RESERVED Single identifier

1.4.3 General Recommendations Relative to Unavailable Features/Modules

As

explained in the previous section, some features are not available in all devices. For unavailable

features, use the following recommendations:

Memory mapping: Memory area of unavailable modules and features are RESERVED, read is
undefined, and write can lead to unpredictable behavior.

Interrupt controllers: Ensure that interrupts of unavailable modules and features are masked in the
MPU subsystem.

DMA: Ensure that DMA requests of unavailable modules and features are masked in DMA
subsystems.

System Control Module (SCM): Unavailable modules and feature pins are not functional and should
not be used.

Power, Reset, and Clock Management Module (PRCM): For power management and power-saving
consideration, ensure that power domains of unavailable features/modules are switched off and clocks
are cut off.

Interconnect: To flag potential interconnect outstanding commands, the time-out of target agents
attached to unavailable modules can be enabled with the lowest setting.
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This chapter describes memory mapping.

NOTE: This chapter gives information about all modules and features in the high-tier device. To
check availability of modules and features, see Chapter 1, Device Family. The memory area
of unavailable modules and features is RESERVED, read is undefined, and write can lead to
unpredictable behavior.
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2.1 Introduction

The microprocessor unit (MPU) has a 32-bit address port, allowing it to handle a 4Gbytes space divided
into several regions, depending on the target type.

The memory map is composed of a memory space (general-purpose memory controller [GPMC], external
memory interface [EMIF4], etc.), register space (L3 and L4 interconnects), and dedicated spaces (SGX,
etc.), all of which are shared among the initiators (for example, the MPU subsystem or the display
subsystem).

The GPMC and EMIF4 are dedicated to memory connection. The GPMC is used for NOR/NAND flash and
PSRAM memories. The EMIF4 is used for DDR2. For more information, see the Memory Subsystem
chapter.

The L3 interconnect allows the sharing of resources, such as peripherals and external or on-chip
memories, between all the initiators of the platform. The L4 interconnects control access to the
peripherals.

Transfers between initiators and targets across the platform are physically conditioned by the chip
interconnect and can be logically conditioned by firewalls. For more information about the
intercommunication (L3 and L4 interconnects) and protection mechanisms implemented in the device, see
the Interconnect.

NOTE: Some features may not be available or supported in your particular device. For more
information, see Chapter 1, Device Family, and your device-specific data manual.

Figure 2-1 shows the interconnect of the device and the main modules and subsystems in the platform.
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Figure 2-1. Interconnect Overview
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2.2 Global Memory Space Mapping
This section provides a global view of the memory mapping and details the boot, GPMC, EMIF4, and
virtual rotated frame buffer (VRFB) memory spaces.
The system memory mapping is flexible, with two levels of granularity for target address space allocation:
» Level 1: Four quarters are labeled QO, Q1, Q2, and Q3. Each quarter corresponds to a 1Gbyte
address space (total address space is 4Gbhytes).
» Level 2: Each quarter is divided into eight blocks of 128Mbytes, with target spaces mapped inside the
blocks.
This organization allows all target spaces to be decoded based on the five most significant bits (MSBs) of
the 32-bit address ([31:27]).
 Boot space
The system has a 1Mbyte boot space either in the on-chip boot ROM or on the GPMC memory space.
When booting from the on-chip ROM with the appropriate external sys_boot5 pin configuration, the
1Mbyte memory space is redirected to the on-chip boot ROM memory address space [0x4000 0000 —
0x400F FFFF].
When booting from the GPMC with the appropriate external sys_boot5 pin configuration, the memory
space is part of the GPMC memory space.
For more information on sys_boot5 pin configuration, see the Memory Subsystem and Initialization
chapters.
* GPMC space
Eight independent GPMC chip-selects (gpmc_ncs0 to gpmc_ncs7) are available in the first quarter
(QO0) of the addressing space to access NOR/NAND flash and PSRAM memories. The chip-selects
have a programmable start address and programmable size (16Mbytes, 32Mbytes, 64Mbytes, or
128Mbytes) in a total memory space of 1Gbyte.
« EMIF4 space
Two EMIF4 chip-selects (emif4_ncsO and emif4_ncsl) are available on the third quarter (Q2) of the
addressing space to access SDRAM memories. The base address of EMIF4 space starts at 0x8000
0000. For more information on EMIF please refer to MemorySubsystem Chapter.
* VRFB space
The EMIF4-SMS virtual memory space is a different memory space used to access a subset of the
EMIF4 memory space through the rotation engine. The virtual address space size is 768Mbytes split
into two parts: The first 256M-byte part is in the second quarter (Q1) of the memory; the second
512Mbytes part is in the fourth quarter (Q3) of the memory.
For more information on GPMC, EMIF4, and VRFB, see the Memory Subsystem chapter.
This section gives information about all modules and features in the high-tier device. To check availability
of modules and features, see Chapter 1, Device Family. The memory area of unavailable modules and
features is RESERVED, read is undefined, and write can lead to unpredictable behavior.
Table 2-1 describes the global memory space mapping.
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Table 2-1. Global Memory Space Mapping

Start Address

End Address

QUARTER Device Name (HEX) (HEX) Size Description
Qo Boot space® 1MB
(1GB) GPMC 1GB
or 1GB-1MB
GPMC 0x0000 0000 Ox3FFF FFFF 1GB 8/16 Ex®/R/W
Q1 On-Chip 128MB ROM/SRAM address space
(1GB) Memory
Boot ROM 0x4000 0000 0x4001 3FFF 80KB 32-bit Ex®/R — Secure
internal® 0x4001 4000 0x4001 BFFF 32KB  32-bit ExX?/R — Public
Reserved 0x4001 C000 0x400F FFFF 912KB Reserved
Reserved 0x4010 0000 0x401F FFFF 1MB Reserved
SRAM internal 0x4020 0000 0x4020 FFFF 64KB 32-bit EXP/R/W —
Secure/public®
Reserved 0x4021 0000 0x4024 FFFF 256KB Reserved
Reserved 0x4025 0000 Ox47FF FFFF 128,704KB  Reserved
_L4 128MB All system peripherals
interconnects
L4-Core 0x4800 0000 0x48FF FFFF 16MB See Table 2-3.
(L4-Wakeup)® (0x4830 0000) (0x4833 FFFF) (256KB) (See Table 2-4.)
L4-Per 0x4900 0000 0x490F FFFF 1MB See Table 2-5.
Reserved 0x4910 0000 Ox4FFF FFFF 111MB Reserved
SGX 64MB Graphic accelerator slave
port
SGX 0x5000 0000 0x5000 FFFF 64KB Graphic accelerator slave
port
Reserved 0x5001 0000 0x53FF FFFF 65,472KB  Reserved
L4 Emulation 64MB Emulation
L4-Emu 0x5400 0000 0x547F FFFF 8MB See Table 2-6.
Reserved 0x5480 0000 0x57FF FFFF 56MB Reserved
Reserved 64MB Reserved
Reserved 0x5800 0000 0x5BFF OFFF 64MB Reserved
IPSS 64MB IPSS
IPSS 0x5C00 0000 OX5EFF FFFF 48MB IPSS. See Table 2-8.
Reserved 0x5F00 0000 Ox5FFF FFFF 16MB Reserved
Reserved 128MB Reserved
Reserved 0x6000 0000 0x67FF FFFF 128MB Reserved
L3 Interconnect 128MB Control Registers
L3 Control 0x6800 0000 0x68FF FFFF 16MB See Table 2-2.
Registers
Reserved 0x6900 0000 Ox6BFF FFFF 48MB Reserved
SMS registers 0x6C00 0000 O0x6CFF FFFF 16MB Configuration registers SMS
address space 2
EMIF4 registers 0x6D00 0000 0x6DFF FFFF 16MB Configuration registers SMS
address space 3
GPMC registers 0x6E00 0000 OX6EFF FFFF 16MB Configuration registers
GPMC address space 1
Reserved 0x6F00 0000 Ox6FFF FFFF 16MB Reserved

(€]
@
®)
@)

Boot space location depends on the external sys_boot5 pin configuration.

Executable

Default public/secure settings after reset only
Peripherals connected to the L4-Wakeup interconnect are accessed through the L4-Core interconnect.
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Global Memory Space Mapping

Table 2-1. Global Memory Space Mapping (continued)

Start Address

End Address

QUARTER Device Name (HEX) (HEX) Size Description
EMIF4/SMS 256MB EMIF4/SMS
EMIF4/SMS 0x7000 0000 Ox7FFF FFFF 256MB EMIF4-SMS virtual address
virtual space 0
Address space 0
Q2 EMIF4/SMS 1GB SDRAM main address
(1GB) space (SMS)
SDRAM 0x8000 0000 OXBFFF FFFF 1GB EMIF4/SMS
Q3 Reserved 512MB Reserved
ey Reserved 0xC000 0000 OxDFFF FFFF 512MB Reserved for future use.
EMIF4/SMS 512MB EMIF4/SMS
EMIF4/SMS 0xE000 0000 OXFFFF FFFF 512MB EMIF4-SMS virtual address
virtual space 1

Address space 1
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2.3

231

L3 and L4 Memory Space Mapping
The memory space system is defined from a hierarchical view: L1, L2, L3, and L4.
L1 memory includes the MPU subsystem.

The chip-level interconnect, which is made of one L3 and four L4s, enables communication between all
modules and subsystems.

L3 handles many types of data transfers and, in particular, the data exchange with system on-
chip/external memories.

The four L4s that handle transfers with peripherals are: the L4-Core, L4-Wakeup, L4-Per, and L4-Emu
interconnects.

For more information about the interconnect, see the Interconnect chapter.

The following sections describe the register mapping of the L3 and L4 interconnects. The software
configures these registers.

L3 Memory Space Mapping

The L3 interconnect control registers are mapped in a 16Mbytes space and allow the configuration of the
L3 interconnect parameters.

The L3 default settings are fully functional and enable all possible functional data paths. However, the
interconnect parameters can be changed to accommodate expectations.

Accesses to the L3 interconnect can be configured on a per-module basis using the internal L3 registers,
which are grouped into five register block types:

* |A: initiator agent configuration registers

» TA: target agent configuration registers

* RT: register target (global configuration registers)

e PM: protection mechanism (firewalls) configuration registers
» SI: global sideband signal configuration registers

For more information, see the Interconnect chapter.

This section gives information about all modules and features in the high-tier device. to check availability
of modules and features, see Chapter 1, Device Family. The memory area of unavailable modules and
features is RESERVED, read is undefined, and write can lead to unpredictable behavior.

Table 2-2 describes the mapping of the L3 interconnect control registers.

Table 2-2. L3 Control Register Mapping

Start Address End Address

Device Name (HEX) (HEX) Size Description

L3 RT 0x6800 0000 0x6800 03FF 1KB L3 configuration registers

L3 SI 0x6800 0400 0x6800 07FF 1KB Sideband signals configuration

Reserved 0x6800 0800 0x6800 13FF 3KB Reserved

MPU SS IA 0x6800 1400 0x6800 17FF 1KB MPU subsystem instruction port agent
configuration

Unused 0x6800 1800 0x6800 1BFF 1KB Unused

SGX SS 1A 0x6800 1C00 0x6800 1FFF 1KB SGX subsystem initiator port agent
configuration

SMS TA 0x6800 2000 0x6800 23FF 1KB SMS target port agent configuration

GPMC TA 0x6800 2400 0x6800 27FF 1KB GPMC target port agent configuration

OCM RAM TA 0x6800 2800 0x6800 2BFF 1KB OCM RAM target port agent
configuration

OCM ROM TA 0x6800 2C00 0x6800 2FFF 1KB OCM ROM target port agent
configuration

Reserved 0x6800 3000 0x6800 3FFF 4KB Reserved
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Table 2-2. L3 Control Register Mapping (continued)

Start Address End Address

Device Name (HEX) (HEX) Size Description

HS USB HOST IA 0x6800 4000 0x6800 43FF 1KB HS USB HOST initiator port agent
configuration

IPSS 1A 0x6800 4400 0x6800 47FF 1KB IPSS

Reserved 0x6800 4800 0x6800 4BFF 1KB Reserved

sDMA RD IA 0x6800 4C00 0x6800 4FFF 1KB sDMA RD initiator port agent
configuration

SsDMA WR |A 0x6800 5000 0x6800 53FF 1KB sDMA WR initiator port agent
configuration

Display SS IA 0x6800 5400 0x6800 57FF 1KB Display subsystem initiator port agent
configuration

Unused 0x6800 5800 0x6800 5BFF 1KB Unused

DAP IA 0x6800 5C00 0x6800 5FFF 1KB Debug access port initiator port agent
configuration

IPSS TA 0x6800 6000 0x6800 63FF 1KB IPSS Target Port agent configuration

SGX SSTA 0x6800 6400 0x6800 67FF 1KB SGX subsystem target port agent
configuration

L4-Core TA 0x6800 6800 0x6800 6BFF 1KB L4-Core target port agent
configuration

L4-Per TA 0x6800 6C00 0x6800 6FFF 1KB L4-Per target port agent configuration

Reserved 0x6800 7000 0x6800 FFFF 36KB Reserved

RT PM 0x6801 0000 0x6801 03FF 1KB Register target port protection

Reserved 0x6801 0400 0x6801 23FF 8KB Reserved

GPMC PM 0x6801 2400 0x6801 27FF 1KB GPMC target port protection

OCM RAM PM 0x6801 2800 0x6801 2BFF 1KB OCM RAM target port protection

OCM ROM PM 0x6801 2C00 0x6801 2FFF 1KB OCM ROM target port protection

Reserved 0x6801 3000 0x6801 3FFF 4KB Reserved

IPSS PM 0x6801 4000 0x6801 43FF 1KB IPSS

Reserved 0x6801 4400 0x68FF FFFF 16,303KB  Reserved

2.3.2 L4 Memory Space Mapping
The device contains four L4 interconnects: the L4-Core, L4-Wakeup, L4-Per, and L4-Emu interconnects.

As with the L3 interconnect, the L4 interconnects can be configured to tune the access depending on the
characteristics of each module.

For more information on the L4 interconnect, see the Interconnect chapter.

2.3.2.1 L4-Core Memory Space Mapping

The L4-Core interconnect is a 16Mbytes space composed of the L4-Core interconnect configuration
registers and the module registers.

Table 2-3 describes the mapping of the registers for the L4-Core interconnect.

NOTE: All memory spaces described as modules provide direct access to module registers outside
the L4-Core interconnect. All other accesses are internal to the L4-Core interconnect.

This section gives information about all modules and features in the high-tier device. To check availability
of modules and features, see Chapter 1, Device Family. The memory area of unavailable modules and
features is RESERVED, read is undefined, and write can lead to unpredictable behavior.
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Table 2-3. L4-Core Memory Space Mapping ©

Start Address

End Address

Device Name (HEX) (HEX) Size Description
L4-Core 0x4800 0000 0x48FF FFFF 16MB
Reserved 0x4800 0000 0x4800 1FFF 8KB Reserved
System control module 0x4800 2000 0x4800 2FFF 4KB Module
0x4800 3000 0x4800 3FFF 4KB L4 interconnect
Clock manager 0x4800 4000 0x4800 5FFF 8KB Module region A
* DPLL 0x4800 6000 0x4800 67FF 2KB Module region B
* Clock manager 0x4800 6800 0x4800 6FFF 2KB Reserved
0x4800 7000 0x4800 7FFF 4KB L4 interconnect
Reserved 0x4800 8000 0x4802 3FFF 112KB Reserved
Reserved 0x4802 4000 0x4802 4FFF 4KB Reserved
0x4802 5000 0x4802 5FFF 4KB Reserved
Reserved 0x4802 6000 0x4803 FFFF 104KB Reserved
L4-Core configuration 0x4804 0000 0x4804 07FF 2KB Address/protection